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Bu uslubiy ko’rsatmada rastrli va vektorli kompyuter 

grafikasining eng ko’p tarqalgan Adobe Photoshop va Corel Draw 

dasturlari bilan tanishib chiqilgan. Ushbu dasturlarning  bosh 

menyusi bulimlari, asboblar paneli, rasm chizish, matn yaratish va 

turli taxrirlash  ishlarini bajarish xaqida   ma’lumotlar berilgan. 

«Кompyuter grafikasi» fani turli texnik ta’lim yo’nalishlari 

bo’yicha kadrlarni tayyorlashda fundamental ahamiyatga ega bo’lgan 

mustaqil fandir. 

Bakalavrlar ushbu mavzularni o’zlashtirish natijasida  o’z 

mutaxassisliklarida zamonaviy kompyuter texnologiyalaridan  

to’laqonli foydalanishga ega bo’ladi. 

Ushbu uslubiy ko’rsatma «Кompyuter grafikasi» fanidan amaliy 

ishlarini o’tkazishda nafaqat bakalvrda ta’lim olayotgan talabalarga, 

balki magistrlar, aspirantlar  uchun xam tavsiya etiladi. 
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1-Amaliy mashg’ulot 

 

Adobe Photoshop 7.0 Programmasi bilan tanishuv 

 

Ishning maksadi: Adobe Photoshop 7.0 programmasining 

imkoniyatlarini o’rganish 

Programma funktsiyalari bilan tanishuv 

 

Vazifa: 

1. Dasturning ishchi soxasi, asboblar guruxi, funktsional panellar, 

hamda ularning imkoniyatlari bilan tanishuv. 

 

                               Nazariy qism. 

 

Programmani ishga tushirish: Windows 95, 98, ME, 2000, XR ili 

NT operatsion sistemasida ke Start (Pusk) tugmasiga bosing paneli 

zadach bo’limida joylashgan Programs (Programmy) bo’limiga 

kiring so’ngra Adobe, Photoshop 7.0 ichidagi  Adobe Photoshop 

7.0 elementi ustiga sichqoncha bilan bosing . Adobe Photoshop 7 

programmasi mavsum programmalar orasida   superxit produktga 

aylandi. Uni ustiga bu programmaning xar bir soni  o’zida yangi 

elementlarni mujassamlashtirgan. Bu o’zgarishlar Photoshop 07 

versiyasida xam kuzatiladi. Ishlab chiqaruvchilar bu programmadagi 

bir qator kamchiliklarni bartaraf qilishdi , bularga Windows i Mac 

OS X. Qismida , Photoshop 7 nixoyat virtual xotira sistemasini 

ishlaishni o’gandi , natijada Operativ xotiraning bir qancha qismi 

tejab qolindi. Bu tejmkorlik kata xajimga ega bo’lgan  tasvirlar Bilan 

ishlaganda seziladi. Shuningdek operatsion sistemani osilib qolishi 

kamaydi. Xozirda  Photoshop boshqa bir qancha daturlar Bilan bir 

vaqtda yaxshi ishlashi mumkun. 
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Ras 1.1. Photoshop 7 ekran ko’rinishi. 

Rasmda Photoshop programmasida ishlash payti ko’rsatilgan. (1) 

tugmasi bosib boshqaruv menyusi ishga tushiriladi. U o’zida quydagi 

buyruqlar (komanda)larni mujassamlashtirgan: Restore (Qayta 

tiklash(Vosstanovit)), Move (Siljitish(Peremestit)), Size 

(Ulchami(Razmer)), Minimize (Pastga tushirish(Svernut)), 

Maximize (Ochish(Razvernut)) va Close (Yopish(Zakryt)). (7) 

tugmasi yordamida xujjatni boshqarish menyusi ishga tushiriladi. 

Asosiy menyuda quydagicha komandalar mavjud: Restore 

(Vosstanovit), Move (Peremestit), Size (Razmer), Minimize 

(Svernut), Maximize (Razvernut), Close (Zakryt) va Next 

(Кeyngi(Sleduyuщiy)).  

 

      Photoshop va ImageReady programmalariga tasvirni tez ko’rib 

chiqish  moduli kiritilgan. Oldin esa bu ishni amalga oshirish uchun 
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tashqi programma(utilit)lar ishlatilardi masalan ACDSee yoki 

ThumbsPlus. (PDA) chuntak kompyuterlari uchun rasimni importi va 

eksporti WBMP formatli filtrlari kiritilgan.  Кompyuterning ishlash 

chegarasi doirasida avtomatik tarzda rasmning sifatini buzmagan 

xolda moslashuv(optimizatsiya)ni bajaradi. 

Photoshop 7 programmasiga gurux(gruppovoy) bo’lib ishlash uchun 

qushimcha imkoniyatlar kiritildi. Bu bir kompyuterda turli 

foydalanuchilar tominidan Adobe programmasida ishlash 

imkoniyatini beradigan AfterCast kengaytkich qushildi. Agar bir 

foydalanuvchi tasvirga o’zgartirish kiritsa bir vaktni o’zida xama 

foydalanuvchilar kuzata oladi. Ammo AfterCast sozlash(nastroyka)ni 

fakat administrator boshqara oladi, lekin bu o’z uy kompyuterlarida 

Photoshop programmasida ishlovchi foydalanuvchilar bu muammoga 

duch kelmaydilar. Biz yuqorida faqatgina Photoshop 7ni asosiy 

imkoniyatlarini sanab chiqdik. 

Asboblar paneli(panel instrumentov) 

        Ekranda turgan programma asboblarini ishga tushirish uchun 

sichkoncha Bilan uniustiga bosing va ekranda kurinayotgan 

piktogrammani ustiga bosing. Bir xil piktogrammalar yonida kichik 

kursatkich(strelochka)lar mavjud. Agar uni ustiga bosilsa tasvirga 

tugri keluvchi oyna(palitra)lar ko’rsatiladi, u erdan siz kerakli 

asboblarni tanlashingiz mumkin. Xar bir asbob uchun o’zining 

o’lcham(parametr)lari ekran teppasida joylashgan optsiyalar panelida 

mavjuddir (masalan, rejim smeshivaniya, znachenie neprozrachnosti) 

. 

 

 

Ris. 1.2. asboblar panelida paydo buluvchi maslaxat(podskazka) 

oynasi 

Eslatma :Edit > Preferences > Display& Cursors (Pravka > 

Ustanovki > Otobrajenie&kursory) oynasida kursor va asboblar  

piktogrammalari ko’rinishlarini so’zlash mumkun.  

Optsiyalar paneli (Panel optsiy)  
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Optsiyalar paneli xar bir asbobning parametorlarini sozlash 

uchun ishlariladi(masalan, shaffoflik darajasi yoki tasvirni 

aralashtirish rijimini) -  1.3 rasm . Optsiyalar panelining ung 

tomonida maxsus ranglarni saqlovchi bulim mavjuddir. Parametrlarni 

ko’ursatilishi qaysi rasmni tanlanganiga bog’liq(1.3-1.8 rasm). 

Foydalanuvchi tomonidan kiritilgan tasvir ko’rinishi  boshqa 

o’zgartirishlar kiritilguncha saqlanadi. Palitra va optsiyalar panelini 

xam ekranni istalgan joyga siljitish mumkin.  

 
Ris. 1.3. Brush asbobi uchun optsiyalar paneli   

 
Ris. 1.4. Rectangular Marquee asbobi uchun optsiyalar paneli   

 

 
Ris. 1.5. Gradient asbobi uchun optsiyalar paneli    

 
Ris. 1.6. Rep asbobi uchun optsiyalar paneli    

 
Ris. 1.7. Rectangle asbobi uchun optsiyalar paneli    

 
Ris. 1.8. Ture asbobi uchun optsiyalar paneli    
Eslatma:  Edit > Preferences > Display& Cursors (Pravka > 

Ustanovki > Otobrajenie&kursory) oynasida kursor va asboblar 

panelidagi asbob piktogrammasini tanlashingiz mumkun. 

  NaOptsiyalar panelining o’ng tomonida aktiv asbob piktogrammasi 

ko’rsatilgan. Agar piktogramma yonidagi  strelka ustiga bosilsa , 

ko’rinmay turgan menyu ochiladi, unda boshqa kerakli bo’lgan 

asbobni tanlash mumkun. Bu jadvalga uzgartirishlar kiritish mumkun 

yani kam ishlatilayotgan asboblarni olib tashlab urniga kerakli 

bo’lgan asboblarni joylash mumkun. Xar bir  optsiyalar paneliga 

kiritilgan uzgartirishlar avtomatik tarzda saqlanib qolinadi. 

Tugmalarni qayta tiklash va joylashtirish uchun paydo bo’luvchi 

paneldan amalga oshiriladi. 

Paydo buluvchi yordamchi maslaxatlar(vsplyvayuщie podskazki)  
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Istalgan piktogramma ustiga sichqonchani bosmasdan olib boring 

shunda siz ishlatmoqsi bo’lgan asbobning nomi va uni klaviatura 

orkali ishga tushiradigan tugmachalar ko’rsatiladi. Shu bilan bir 

qatorda ishlatilayotgan optsiyalar oynasi va uning vazifasi xaqida 

qisqacha malumot olish mumkin (1.9 rasm). Edit > Preferences > 

General (Pravka > Ustanovki > Obщie) oynasidagi yordamchi 

maslaxtlar oynasini ishlatish uchun Show Tool Tips oynasi ustiga 

bayroqchani o’rnating (Pokazivat ispravlayushie podskazki)   

 
Ris. 1.9. Optsiyalar panelidagi yordamchi maslaxatlar 

Programmaning barcha komandalari uchun Asosiy menyu 

(Glavnoe menyu) mavjuddir: 

 
Ris. 1.10. Asosiy menyu 
File (Fayl) menyusi quydagi xolatlarda ishlatiladi: 

yaratish(sozdat), ochish(otkryt), joylashtirish(razmestit), 

yopish(zakryt), saklash(soxranit), skanirlash(otskanirovat), import va 

eksport, kog’ozga chiqarish(napechatat izobrajenie), Faylni tarmoq 

orqali o’zatish(peredat fayl po seti), bir nechta optsiyalarni 

avtomatlashtirish uchun va albatta Photoshop dasturidan chikish 

uchun. 

Edit (Pravka) menyusida, tasvirni redaktirlash yani sozlash 

uchun komandalar: nusxalash(kopirovaniya), 

o’zgartirish(transformatsii), joylashtirish va tasvir ranglarini tusini va 

muyqalam qalinligi va turini tanlash mumkin. 

Mode (Rejim) menyuosi orqali Image (Izobrajenie) menyusi, 

tasvir sakkiz turdagi  tasvir urinishlarini tanlash mumkin. 

Layer (Sloy) menyusida joylashgan komandalar, bir necha 

qatlamlardan joylashgan tasvir ustidagi amallar yani: qatlamlar aro 

bog’lanishni qatlamlar ketma ketligini va qatlamlarni umumiy 

qatlamga birlashtirish imkoniyatini beradi. 

Select (Vydelit) menyusida joylashgan komandalar – kerakli 

qatlamlarni tanlashda ishlatiladi. 

Filter (Filtr) menyusi o’zida tasvirlarni birlashtirish va umumiy 

xolga keltirish uchun kerakli bo’lgan filtiri mavjuddir. 
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View (Vid)menyusidagi komandalar, ekrandagi tasvirni 

ko’rinishlarini nazorat qiladi. 

Window (Okno) menyusi komandalari, ekrandagi boshqa 

tasvirlarni aks ettiradi va ulardan kerakli bo’lgan paytda foydalanish 

imkonini beradi. 

Help (Pomosh) menyusidagi komandalar foydalanuvchi uchun 

kerakli bo’lgan maslaxatlar orqali ko’mak va xozirda bajarish 

mumkun bo’lgan imkoniyatlar bilan tanishtiradi xamda Photoshop 

ihtiyoriy saytiga murojat qilsh imkoniyatini beradi.  

Istalgan tasvirni xoxlagan paytda uzgartirishlar kiritish imkonini 

va 12 turdagi Photoshop kengaytma(format)larida saqlash imkonini 

beradi. Ammo odatta asosiy kuydagi Photoshop formatlari ishlatilad: 

TIFF, GIF, JPEG, EPS. 

Photoshop programmasida ko’pgina operatsiyalar asosan 

politralar orqali bajariladi. Ekranda ko’p joy egalamasligi uchun 

politralar o’zaro guruxlarga biriktirilgan: Navigator/Info 

(Boshkaruv/Informatsiya), Color/Swatches/ Styles 

(Rang/Namuna/Uslublar), History/Actions/Tool Presets 

(Tarixi/Xarakatlar/Asboblar tanlash), Layers/Channels/Paths 

(Кatlamlar/Кanallar/Кonturlar) i Character/Paragraph 

(Shrift/Abzats). 

 

Palitralar (palitry)  

Photoshop programmasida ko’p operatsiyalar palitralar orqali 

bajariladi ularni o’zaro aralashtirish xam mumkun. Istalgan palitrani 

ochish uchun esa Window (Okno) menyu komandasidan amalga 

oshiriladi. Belgilangan palitra boshqa  shu gkruxga kiruvchi 

politralardan eng yuqrida avtomatik tarizda joylashadi. 

Photoshop progrpmmasidan chikish: Windows  Operatsion dasturida 

bu dastur oynasini yopish uchun File > Exit (Fayl > 

Vyxod)menyusidan kursatilgan komandani tanlang yoki (Ctrl+Q) 

tugmalar kombinatsiyasini bosing 

 

 

Nazorat savollari: 

 

1. Adobe Photoshop 7.0 dasturi qanday ishga tushiriladi? 
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2. Adobe Photoshop 7.0 dasturining asosiy menyust nimalardan 

tashkil topgan? 

3. Optsiyalar paneli nima uchun ishlatiladi? 

4. Palitra operatsiyalari orqali nima bajarish mumkun ? 

 

 

2- Amaliy mashg’ulot 

 

Adobe Photoshop dasturida tasvir va rasm bilan ishlash 

 

Ishning maqsadi: Skaner orqali olingan tasvirni o’zgartirish va 

asboblar paneli orqali tasvirni yaratish . 

 

       Vazifa: 

 

1. Brush asbobliri bilan tanishish. 

2. Brush asbobi yordamida tasvirga shrixlar va o’zgartirishlar 

kiritish.  

3. Matnli xujjat yaratish. 

 

Nazariy qism. 

Adobe Photoshop Windows Muxitida ishlovchi Macintosh va IBM 

PC kompyuterlari uchun muljallangan elektron ko’rinishdagi foto 

tasvirlarini taxrirlovchi programmadir.    Adobe Photoshop 

programmasi    Adobe System, Inc kompaniyasi tomonidan ishlab 

chiqarilgan bo’lib, ishlatishdagi aloxida qulayliklari bilan mashxur. 

         Adobe Photoshop tasvir taxrirlagichi erdamida fotosuratlarga 

qo’shimchalar kirish , fotosuratdagi dog’larni o’chirish , eski 

rasmlarni qayta ishlash  va tiklash. Rasmlarga  matn kiritish 

qushimcha maxsus effektlar bilan boytish, bir fotosuratdagi 

elementlarni ikkinchi fotosuratga olib o’tish, suratdagi ranglarni 

o’zgartirish almashtirish mumkin.    Adobe Photoshop imkoniyatlari 

keng qamrovli bo’lib, u gazeta va jurnallarni turli tuman rasmlar 

bilan boyitishda juda katta qulayliklar yaratadi. 

       Adobe Photoshop ayniqsa jurnalistlarning, rassomlarning ijodiy 

imkoniyatlarini to’la amalga oshirishlarida yordam beradi, 

Jurnalistika va bevosita matbuot yoki nashriyot soxasiga aloqador 
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bo’lgan shaxslarning mazkur programma bilan ishlashni bilishi  

uchun  ko’shimcha imkoniyatlarni yaratib beradi. 

     Adobe Photoshop tasvir taxrirlagichi juda murakkab 

programmadir. Foydalanuvchilar uning asosiy imkoniyatlaridagina 

foydalanadilar xolos.Optsiyalar panelida Brush (muyqalam) 

muyqalami uslubini tanlash uchun strelkasi ustiga bosing( 2.1 rasm). 

Xaar bir piktogramma ustidagi raqamlar muyqalamni qalinligini 

piksellarda ko’rsatadi. Agar siz istalgan muyqalam ustiga olib 

borsangiz shu muykalamning qalinligi va turi xaqida malumot 

chiqadi. (Boshqa turdagi muyqalamlarni tanlash uchun 12chi qismda 

keltirilib utilgan «Muyqalamlar kutubxonasini yuklash(Zagruzka 

biblioteki kistey)»). Muyqalam panelini yopish uchun paneldan 

tashkaridagi ekranning istalgan joyga bosing va avtomatik tarizda 

panel yopilpdi. Mode (Aralashtirish rijimi(Rejim 

smeshivaniya))bo’limini tanlang, xamda Opacity 

(Shafofsizlik(Neprozrachnost)) bulimini foyz kursakichida Brush 

(Кist) asbobi uchun tanlang ( 2.2.rasm) qarang. Agar ko’rsatilgan 

qisim parametri 100% ni tashkil qilsa muyqalam shtrixi pastki 

piksellarni mutloq koplaydi. 

 
Ris. 2.1. Muyqalam shaklini tanlash paneli  

Eslatma:Fakatgina shfof bo’lmagan qatlamlarni rangini 

o’zgartirish uchun Layers (Кatlam(Sloi)) palitrasidagi Lock 
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transparent pixels (Zafiksirovat prozrachnye tochki) ustiga 

biyroqchani urnating. 

  
Ris. 2.2. Opacity parametirini belgilash  

Photoshop 7.0  programmasi yordamida siz birqancha standart 

muyqalamlar yoki o’zingiz ulchamlari va ko’rinishini kiritgan xolda 

juda qiziqarli rassomchilik ishlarini amalga oshirishingiz mumkin(2.3 

rasm).  

Rasmlar bilan ishlash uchun yangi protsessor o’ta qiziqarli 

bo’lgan rasmlarni yaratish imkonini beradi. Photoshop 7.0 

programmasida standart va avvaldan foydalanuvchi kiritgan 

rasmlarni nusxalab unga saykal berish  shu bilan birga tasvirga xul va 

kuruk muykalam usullarida bezak berish mumkin. Muyqalam 

paketiga barg va utlarni tasvirini yaratadigan maxsus effekt 

muyqalamlari kitildi. Maxsus original tasvirlarni yaratish uchun 

skanerdan o’tkazilgan rasm va tekstlarni orqa fon sifatida shaffof 

ko’rinishda tasvirga kiritish mumkin.  Photoshop 07 programmasi 

protsessori faqat yangi tasvir yaratish imkoniyatlar bilan cheklanib 

qolmay balki, boshqaruvning sodalashganligi e’tiborga olingan. 
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Ris. 2.3. Xar xil turdagi muyqalamlar bilan  Brush asbobi bilash 

chizilgan chiziqlar  
Mavjud bo’lgan muyqalamni uzgartirish(Izmenenie suщestvuyuщey 

kisti)  
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Photoshop programmasiga qo’shimcha sifatida muyqalamlar 

ombori xam beriladi va siz u erdan istalgan muyqalamni tanlab uni 

xoshingizga ko’ra uzgartirish (modifikatsiya) qilishingiz mumkin.  

1. Optsiyalar panelidan Brushes (Muyqalam(Кist)) tugmasiga 

bosing undagi menyudan Brush Tip Shape - sm.  2.4 rasm bo’limini 

tanlang.   

2. Diameter (Diametr) efektni kerakli joygacha chuzing yoki 

muyqalam diametirini kiriting    (1 dan 999 pikselgacha).  

3. Muyqalam izi shaffofsizligini belgilovchi Hardness 

(Кattiklik(Jestkost)) koyfitsentini tanlang yoki uni xam foyz 

miqdorda kiriting (0-100%gacha).  

4. Muyqalam qoldirgan izlari uzoqligini Spacing (Interval) orqali 

bajariladi (0-999%)  foyz miqdorini oshirilgan sari shtrixlar orasidagi 

masofa kattalashib boradi. Shuningdek bu vazifani kursor yoki 

muyqalam xam bajarishi mumkun buning uchun  Spacing (Interval) 

tugmasidan bayroqni olib tashlashni o’zi kifoya o’anchalik kursorni 

tez xarakatlantisangiz shuncha oralio’q kattalashadi va aksi (12 

bo’limni kar, «Vybor optsiy pera» qismi).  

Eslatma :Кo’pgina standart urnatilgan muyqalamlar uchun asosan 

Spacing i Diameter bo’limlarini o’zgartirish mumkin.  

5. Muyqalam izini doira yoki boshqa ellips ko’rinishlarini belgilash 

uchun Angle (Burchak(Ugol)) bo’limidan ( -180° dan +180° gacha) 

qiymatlarni ko’rsating yoki ekranning chap tarafidagi rasmdagi 

strelkani xoxishga ko’ra joylashtiring.  

6. Muyqalamni sochma yoki tiniklashtirish uchun Roundness 

(Okruglost) (0-100%) parametrlarini Bering foiz miqdori ortgani sari 

nuqta izi tiniklashadi.  

Yangi muyqalamni yaratish(Sozdanie novoy kisti)  

1. Brush (muyqalam) menyusidan New Brush (Yangi 

muyqalam) buyrug’ini tanlang.  

2. Mavjud muyqalamni o’zgartirish«Izmenenie 

sushestvuyushiy kisti»  bo’limidan 2 dan 8 gacha bo’lgan 

buyruqlarni tanlang. Create New Brush (Yangi muyqalamni 

yaratish) bo’limiga bir marta bosing va kerakli ulchamlarni Bering 

agar siz Ushbu tayyor muyqalamni saqlab qolmoqchi bo’lsangiz uni 

nomini kiriting va OК tugmasini bosing. (Ammo bu Yangi 

muyqalam xech qaysi bibliotekaga kiritilmaydi.)  Saqlangan 

muykalam piktogrammasi tanlash panelida oxirida joylashadi. 
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Saqlangan muyqalamni bibliotekada saqlash 21 bob, «Yangi 

biblioteada muyqalamni saqlash» bo’limida ko’rsatilgan.  

 

       Ris. 2.4. Muyqalam ulchamlari oynasi  
Tasvirdan iborat bo’lgan muyqalamni yaratish(Sozdanie kisti na 

osnove izobrajeniya)  

1. Rectangular Marquee (Pryamougolnaya oblast) asbobini 

aktivlashtirish uchun klaviaturadan M tugmasini yoki  Shift+M 

tugmalarini bosing.  

2. Ok fonda berilgan figuralar Bilan tasvirni chegarasini 

belgilang(maksimum 1000x1000 pikselgacha). 

3. Edit > Define Brush (Pravka > Muyqalamni aniqlash) 

komandasini tanlang.  

4. Yukrida aytib utilgandek Ushbu Yangi muyqalam nimini 

kiriting va OК tugmasini bosing. Bu muyqalamdan Brush 

(muqalam) menyusi Bilan ishlayotganda foydalanish mumkin. Paydo 

buluvchi muyqalam ulchamlarini Spacing (Interval) tugmasidan 

shtrixlar orasidagi masofani aniklashniring(1-999%).  

5. Belgilangan zonani kaytib uz xoliga keltirish uchun Ctrl+D 

tugmalarini birgalikda bosing.  

Muyqalamni uchirish(Udalenie kisti)  

1. Muqalam tanlash panelini oching.  

2. Birinchi usul: Alt tugmasini bosib turib uchirmokchi bulgan 

muyqalamni belgilang. Bu xarakatni orqaga qaytarish(otmenit) 

mumkin emas.  

Ikkinchi usul: Кeraksiz bo’lgan muqalamni ko’rsating va Delete 

Brush (Muyqalamni uchurish) buyrug’ini tanlang 2.5 rasmga qarang.  

 
Ris.2.5. Muyqalamni uchirish 

 Background Eraser va  Magic Eraser asboblarini ishlatilishi 
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Magic Eraser (Muzizaviy uchirgich) menyusi sichqoncha 

tugmasi Bilan o’chirish imkonini beradi. U siz ko’rsatgan ranga 

yaqin bo’lgan pikellarni o’chiradi. Buni aksini esa Paint Bucket 

(Vedro s kraskoy) asbobi bajaradi. Agar siz shaffofsizlikni 100% dan 

pastrogini tanlagan bo’lsangiz unda  Magic Eraser asbobi orqali 

kerakli joylani shaffof ko’rinishga keltirishingiz mumkin. 

 

 

 

Ris.2.6.   Magic Eraser asbobining optsiyalar paneli 

Background Eraser (fon uchun uchirgish) asabobi bu fondagi 

keraksiz joylarni uchiradi yoki kerakli ranga buyaydi. Bu asbobning 

ustunligi shundaki u bilan aralash fonlarni yakdil xolatga va 

uchirilayotgan zonani yoki chegaralarni xamoxangligini nazorat 

qiladi. 

  
Ris.2.7. Background Eraser asbobining optsiyalar paneli  

Qatlamlarni zonalari uygunligi(Stiranie chasti sloya)  

1. Xoxlagan katlamni tanlang. Eraser (uchirgich) asbodi 

yordamida qatlamdagi keraksiz joylarni uchirmoqchi bo’lsangiz unda 

Lock transparent pixels (Zafiksirovat prozrachnye tochki) bulimiga 

bayroqchani o’rnating shunda o’chirilayotgan qatlam undan oldingi 

qatlamni foniga ega bo’ladi. Agar Lock transparent pixels 

(Zafiksirovat prozrachnye tochki) bo’limidagi bayroqcha olib 

tashlansa unda uchirilgan qisim shaffof xolatga utadi.  

2. Eraser (uchirgich) asbobini E tugmasi yoki Shift+E 

tugmalarini birga bosib uni ishga tushiring.  

3. Optsiyalar panelidan Brush (Кist) bo’limiga kiring va kerakli 

bo’lgan muyqalamni tanlang.  

Mode (Rejim) bo’limidan kerakli rejimni tanlang: u erda  Brush 

(muyqalam), Pencil (qalam) yoki  Block (Blok) larni tanlang 2.8 

rasmga  qarang. Xul buyoqni akslantiruvchi  Brush (Кist) brash 

effektini tanlagn. Opacity (Shaffofsizlik) parametrlarini  ko’rsating.  
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Ris.2.8.   Eraser asbobining optsiyalar paneli 

Avtomatik uchirish rejimi(Rejim avtomaticheskogo stiraniya)  

Auto Erase (Avtolastik) uz uzidan avtomatik tarizda ishlashga 

muljalangandir agar siz unig uz xoxishingizga kura ishlatmochi 

bulsangiz kuydagilarni bajarishingiz shart.  

1. Кerakli bulgan fon rangini tanlang. Bunda Eyedropper 

(Pipetka) asbobidan rang tashlashda foydalanishingiz mumkin.  

2. Кerakli bulgan katlamni belgilang.  

3. Pencil (Кarandash) asbobini aktivlashtiring, buning uchun V 

tugmasi yoki Shift+B tugmalarini birgalikda bosing.  

4. Optsiyalar panelidan  Auto Erase (Avtolastik) asbobi ustiga 

bayrokni urnating.  

5. Tasvtrga shtrixlarni chizing. Asosiy pikseldan boshlab kerakli 

xududgacha kursorni tortib boring yoki boshka singa makul bulgan 

pikseldan boshlashingiz mumkin.  

 

Nazorat savollari: 

 

1.  Brush asbobi imkoniyatlarini sanab bering. 

2.  Background Eraser buyrugi nima uchun ishlatiladi? 

3. Ob’ekt rangi qanday o’zgartiriladi? 

 

3-amaliy mashg’ulot 

 

                            Matnlar bilan ishlash 

Ishninng maksadi: Programma funktsiyalari bilan tanishish. 

 

Vazifa: 

 

1. Matin yaratish va uni taxrirlash. 

2. Yaratilgan matinga effektlarni kulash. 

 

Nazariy qism. 
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Photoshop 07 programmasida matin vektor ko’rinishiga ega. 

Programmada tekst o’zinigng anik chegara va konturlariga ega 

chunki programma matinlarni ishlatayotgarda vektor konturini 

qullaydi. Shu bilan bir qatorda matin xam rasm sifatlarini o’zida 

mujassamlashtirgan. Bu matin printerdan chiqarilishiga qaramay u 

PDF yoki EPS formatlarida saqlanashi va o’z tinnikligini saqlab 

qoladi.  

Photoshop programma faqatgina tekstlarni kiritibgina emas balki 

ularni yozilayotgan vaqtida va yozilgandan so’ng xam ularni tusini 

rangini ko’rinishini xamda yunalishini o’zgartirish mumkin.  

Matinni Yaratish(Sozdanie teksta)  

Photoshop programmasida tekst yozish uchun Ture (Tekst) 

buyrugi tanlanadi va avtomatik tarzda kerakli joyda o’z maxsus 

qatlamiga ega bo’lgan fonda yozila boshlaydi. Istalgan paytda uning 

ko’rinishini uzgartirish mumkun masalan:  shrift, uslub, kegl, rang, 

kerning , treking , oraliqdagi interval, tugi’rlash, teks chiziqlarini 

xajmini. Bundan tashkari bir tekstni o’ziga bir qancha atributlarni 

kiritish mumkin(3.1 rasm). 

Shu bilan bir qatorda tekstning manosini mexanik tarzda uzgartirish 

unga xar xil effektlar kullash va u joylashgan Qatlam ustida bir 

qancha imkoniyatlarni ko’llash mumkin. Tekst qatlami ustida qanday 

ammalar ko’llash mumkin? Unga filtirni kullash, tekstdan tozalash va 

raslarga to’ldirish mumkin. Bu ammalarni bajarish uchun eng avvalo 

tekst qatlamini Layer > Rasterize > Ture (Sloy > Preobrazovat v 

rastrovyy format > Tekst) asbobi orkali belgilab undagi komandani 

tanlash kerak. 3.2 rasmda eng avvalo uni aktivlashnirib sungra filtr va 

turli qatlam effektlari qo’lanilgan.  

Eslatma:Bitmap, Indexed Color i Multichannel, rijimida 

yaratilgan tekst o’z qatlamiga ega bo’lmaydi va tug’ridan tugr’i ekran 

foniga tushadi va uni taxrirlam imkoniyati yuqoladi.  

Turli xildagi tekstlar(taxrirlanadigan va taxrirlanmaydigan) 

ko’rinishlari Ture (Tekst) , Layer (qatlam), Character (Shrift), 

Paragraph (Abzats) asboblari va optsiyalar paneli orqali yaratiladi.  

 
Ris. 3.3. Ture asbobining optsiyalar paneli 

Taxrirlanadigan matin qatlamini yaratish(Sozdanie 

redaktiruemogo tekstovogo sloya)  



 18 

1. Eng avvalo Ture (Tekst) asbobini T tugmasini bosish bilan 

aktivlashtiring.  

2. Sungara tekstni joylashtirish kerak bulgan ekrandagi kisimni 

ulchamlarini sichkocha orkali belgilang(suzlar va tekstlar bir biriga 

tuknashib ketmasligi kerak). Yaxshisi xar bir suzni aloxida katlamga 

yozing shunda ularni bir biridan mustakil ravishda siljitish imkoni 

kulga kiritasiz.  

3. Optsiyalar panelida kuydagi ishlarni bajaring:  

o Ture tugmasiga bosing va tekstning yunalishini 

kursating(gorizontal, vertikal);  

o Shiriftlar oilasini, uslubini keglni tanlang;  

o Shuningdek Anti-aliased (Moslashtirish) menyusidan tekst 

Кatlam chegarasini kursating: Sharp (Tinik) Crisp (kattik),Strong 

(kuchli), yoki Smooth (yumshok). Bu tekstni soyasini kurinishlarini 

tubdan uzgartiradi va tasvirga mosdaydi. 

   

Ris. 3.1. 

Redaktirlanayotgan 

matin             

Uzgartirish va 

effektlar kulanilgan 

tekst 

Alignment 

(Vyklyuchka) 

tugmalaridan biriga 

bosing va kerakli 

bulgan tekstni yozilish chegarasini kursating(ungdan, chapdan, 

urtadan)3.4 ramga karang.  
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Ris. 3.2. 

 
Ris. 3.4. Tekstni tekslash usullari  
Optsiyalar panelidan tekstni rangini ko’rsating. Bundan tashkari 

tekst rangini Swatches (Obraztsy) va Colors (Цveta) palitralaridan 

xam belgilash mumkin.  

4. Ekrandagi oynada tekstni kiriting.  

5. Yangi tekst katlamini yaratish uchun Enter tugmasini bosing 

agar sizga boshqa qatlam kerak bo’lmasa Esc tugmasini bosing.  

Maslaxat: Agar  siz tekstlar Bilan ishlayotganda kompyuter osilib 

qolaversa yoki tezligi kichiklashsa unda ochilgan qolgan kerak 

bo’lmagan shirift oynalarini yoping shunda programma tezligi o’z 

xoliga keladi.  

Maslaxat: xar safar teks yozishda Yang qatlamdan 

foydalaganingiz maqul va xatolikka ega bo’lgan katlamlarni o’chirib 

tashlang  

Tekstni taxrirlash. Tekstga o’zgartirishdan oldin uni 

aktivlashtiring va matindagi Suz jumla va xarifni belgilab o’zgartirish 

kiriting, shuningdek tekstni belgilash uchun tekst ramkasini ustiga 

bosish kifoya.  

Tekstni masshtablash(Masshtabirovanie teksta)  

Horizontal Scale (Masshtab po gorizontali) i Vertical Scale 

(Masshtab po vertikali) buyrqularidan tekstni joylashish shaklini 

o’zgartirish uchun foydalaning. Bir xil tugri ko’rinishdagi 

masshtablash uchun quydagi ammalarga rioya qiling:  
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Ris. 3.5. Mastabni 

kiritish                 Ris. 

3.6. Tekst masshbabini 

uzgartirishdan keyngi 

xolat 
Tekst uchun maxsus 

effektlar(Spetsialnye 

effekty dlya teksta) 

Eng avvalo kuydagilarni eslab koling . agar siz tekstni ramkasini 

masshtabini xajmini va tuzilishini uzgartirish uchun uni 

taxrirlanadigan kurinishda bajarishingiz kerak va sungra tekstga 

maxsus effektlar kushish uchun uri rasm sifatiga keltirib sungar 

effektlarni kulashingiz mumkin. 

V tugmasi orkali ishga tushuriluvchi Move (Siljitish) asbobi orkali 

tekstni trasformatsiya kilish mumkin.  

Show Bounding Box (Pokazat gabaritnuyu ramku) asbobiga 

bayrokchani urnating Layers (Sloi) asbobi orkali kerakli katlamni 

belgilang. Ekranda tekst katlami aks etadi. 

 Yakka xolda kiritilgan jumla va suzlarni kuydagicha uzgartirish 

mumkin:  

 Layers (Кatlam) oytasiga jumlani kiriting va Edit (Pravka) 

menyusidan Free Transform (Proizvolnaya transformatsiya) 

buyrugini tanlang;  

 Sichkoncha Bilan tekst oytasini kerakli shaklni olguncha 

surib boring bu vazifani boshka asboblar yordamida xam bajarish 

mumkin.  

Matinni tavsir va matin orkasida joylashtirish(Otobrajenie teksta 

pozadi sloya s risunkom)  
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1. Tekstli qatlamni yarating.  

2. Shu tekst qatlamidan nusxa oling va uni saqlab qo’ying.  

3. Tekst nusxasini belgilanig va Layer > Type > Convert to 

Shape (Sloy > Tekst > Preobrazovat v figuru) komandasini tanlang. 

Tekst qatlami avtomatik rasmga aylanadi va uni taxrirlash endi 

mumkin emas.  

4. Layer > Change Layer Content > Levels (Sloi > Izmenit 

soderjimoe sloya > Urovni) komandasini tanlang 3.7 rasmga qarang. 

Yozimgan qatlam siz boshqa qatlamni kiritmagunizcha nusxalash 

omborida qoladi va aktiv bo’lib turadi.  

                             Ris. 

3.7.                                                                     Ris. 3.8. 
5. Yozilgan tekst boshqa tasvirlar bilan xamoxangligini jigarang 

tusga ega bo’lgan piktogramma Input (Vvod ) ustiga bosing va tekst 

rangini ochartiring yoki tukqrtiring   

6. OК tugmasini bosing (3.8 rasm). Ekraning fonnidan bir 

qismiga bosing.  

Кo’rinmaydigan matinlar yaratish(Sozdanie ischezayuщego teksta)  

1. Tekst kiriting va uni qatlamini aktiv xolatda qoldiring.  

2. Layers (katlam) oynasining pstki qismidan Add a mask 

(Dobavit masku) tugmasini bosing. Belgilangan joy yonida kichik 

belgi(maska) paydo buladi.  

3. G klavishasini yoki Shift+G tugmalar kombinatsiyasini 

bosgan xolda Gradient (Gradient) asbobini ishga tushiring. 

4. Gradient asbobi yonidagi strelkani bosin va kerakli rangni 

tanlang. Linear gradient (Lineynyy gradient) tugmasiga bosing va 
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Normal (Normalnyy) rejimini tanlang shaffofsizlik kiymatini 

Bering(1%dan100%gacha).  

5. Tekstni ustiga kerakli bulgan xududni ramka sifatida 

sizkoncha Bilan belgilan vash u qismlar ocharadi yoki tukaradi 3.9 

ramsga karang.  

       Ris. 3. 9. 

Кurinmaydigan 

tekst                         Ris. 3.10. Кatlamga turli effektlarni                  

                                                                                                             

kulanishi  
Maslaxat.  Tekstni effekt Bilan kuchirish uchun u joylashgan 

katlamni aktivlashtiring va  Move (Peremeщenie) asbobini ishga 

tushiring.  

Maslaxat. Agar siz effektni uzgartirmokchi bulsangiz tekst 

joylashgan Кatlam ustiga bosing shunda Layer Style  mulokot 

oynasi paydo buladi undan boshka effektlarni tanlashingiz mumkin.  

Tekst katlamini chegaralarini urash(Obvodka tekstovogo sloya)  

1. Blending Options (Optsii smeshivaniya) paydo buluvchi 

oynasidan Layers (Sloi) buyrugini tanlang.  

2. Style (Stil sloya) oynasining chap tarafida joylashgan Stroke 

(Obvodka) buyrugi ustiga bosing va  Preview (Predvaritelnyy 

prosmotr) asbobiga bayrok urnatilganligini tekshiring. U erdan 

kuydagi bulimlarni kurib chiking va kerakli ulchamlarni Bering: 

Structure (Struktura) Size (Ulcham), Position (Joylashish xolati) 

(ular tashkridan va ichkaridan bulishi mumkin Outside (Snaruji), 

Inside (Vnutri) yoki Center (markazdan)), Blend Mode (Rejim 

smeshivaniya), Opacity (Shaffofsizlik), Fill Type (buyash usuli) i 

Color (rang)  3.11 rasmga karang.  

3. OК  tugmasini bosing (yoki Enter tugmasini bosing).  
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Ris. 3.11.  Tekstga Stroke effektini Gradient buyog’i Bilan 

qo’lanilishi 

Nazorat savollari: 

1. Programmada tekst konturini uzgartirish uchun qaysi 

buyruqlardan foydalaniladi. 

2.  Кaysi asbob yordamida Photoshop programmasida 

matinlarni yaratish mumkin. 

3. Gradient (Gradient) asbobi qaysi tugmalar yordamida ishga 

tushiriladi. 

 

 

4-amaliy mashg’ulot 

 

Adobe Photoshop  dasturida tasvirga ishlov berish. Qatlamlar 

(sloy) bilan ishlash. 

Ishning maqsadi: Photoshop dasturida qatlamlar bilan 

ishlashni o’rganish. 

           Vazifa: 

1. Qatlamlar xaqida tushuncha va yangi qatlam yaratish. 

2. Xosil qilingan qatlam ustida bir nechta ammalar bajarish. 

3. Xosil qilingan hamma qatlamlarni o’chirib tashlash.  

Nazariy qism. 

Qatlamlar xuddi oyna qatlamlariga o’xshagandir faqat tasvir 

bo’lgan joylarigina ko’rinishga egadir. Xar bir qatlam uchun o’zining 

shffoflik darajasi bo’lib uni undan oldingi va kengi turgan qatlamlar 

bilan xamoxangligini moslash mumkin.  Qatlamlarni joylashish 

urnini almashtirish yoki ularni yagona qatlamga birlashtirish 

mumkin. Bir vaqtni o’zida xar xil qatlamlarda turgan tasvirni 

birgalikda o’zgartirish va bir qatlamda turgan rasmni faqat bir 

qismini o’zgartirish mumkin emas.  
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Layers (Sloi) oynasida qatlamlar ustida turgan qatlamdan eng 

tagidagi katlamgacha aks etirilgan. Bunda fon qanlami oxirida 

joylashadi(5.1rasm). Xozirda belgilangan qatlam aktiv bo’lib 

ko’rinadi va faqat shu qatlam utida amallar bajarish mumkin.  

Istalgan qatlamni aktivlashtirish uchun tartiblanish oynasidan uni 

ustiga bosish kerak aktiv bo’lgan qatlam nomi programma nomi 

yonida akslanib turadi.  

 
Ris. 5.1. Layers palitrasi 

Eslatma : Кatta xajimdagi tasvirlar bilan ishlayotganda bajarilib 

bo’lgan qatlamlarni birlashtirgan yoki o’chirib tashlash maqul shunda 

programma ishlash tezlik unimdorligi oshadi va tasvir xajmi 

kamayadi.   

Yangiqkatlam xosil kilish(Sozdanie novogo sloya)  

1. Eng avvalo 100% shaffof qatlam xosil qilish uchun Create 

New Layer  tugmasi ustiga bosing.  

2. Agar qatlamni ulchamlarini o’zingiz beriokchi bo’lsangiz 

unda Alt, tugmasini bosib turgan xolda Create New Layer tugmasini 

bosing va qudagicha yul tuting:  

3.  Name (Imya) bo’limida katlamni nomini kiriting  Group 

With Previous Layer (Sgruppirovat s predudushim sloem) 

bo’limiga bayroqchani urnating. 

4. Layers (Sloi) palitrasidan kuz va muqylam ko’rinishidagi 

piktogrammalarga bayroqchani o’rnating.  

Mode (Rejim smeshivaniya) va Opacity (Neprozrachnost) 

parametrlaridan tasvir uchun Yangi parametrlarini berin(keynchalik 

bu parametrlar uzgartirilishi mumkin).   
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5. OК tugmasini bosing. Yangi qatlam ishlatilayotgan qatlai 

ustida paydo bo’ladi.  

Eslatma: Tasvir xajmini kamaytirish uchun Layers (Sloi) 

menyusidan Palette Options (Optsii palitry) buyrug’ini tanlang va 

shu tasvirga tugri keladigan eng kichik xajmni tanlang.   

Belgilangan qismni qatlamga aylantirish(Prevraщenie vydelennoy 

oblasti v sloy) 

1. Belgilangan qismni xosil qiling.  

2. Layer > New > Layer Via Soru (Sloy > Novyy > Posredstvom 

kopirovaniya) menyusidan komandani bajaring(Ctrl+J tugmalari).  

3. tasvirni belgilangan qismini yulib olib tashlash uchun Layer > 

New > Layer Via Cut (Sloy >Novyy > Posredstvom vyrezaniya) 

komandasini bajaring(Ctrl+ Shift+J tugmalari).  

 

 

Ris. 5.2.  Layer 1 xiralashtirilgan fondan xosil qilingan tasvir 

 

Qatlamni siljitish(Peremeщenie sloya)  Layers (Sloi) oynasida 

o’zgartirish kiritmokchi bulgan katlamni belgilang.  
1.  Move (Peremeshenie) asbobini aktivlashtiring(V klavishasi).  

2. Кatlamni kursorni ushlabturgan xolatda qatlamni siljiting(5.3 

va 5.4rasm).  
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 Ris. 5.3 . Amaldagi tasvir                       Ris. 5.4. Matnli qatlamni      

Move asbobi yordamida      

                                                                                       sititilishi     

Primechanie:  Auto Select Layer (Avtovydelenie sloya) mulimida 

bayrokcha turgan bulsa Move (Peremeщenie) asbobi yordamida 

tezda katlamni siljitish mumkin, ammo bu sijitish shaffofligi 50% 

dan kam bo’lgan  qatlamlar uchun ishlamaydi.   

Qatlamlar bilan ishlash uchun asboblar(Instrumenty dlya raboty so 

sloyami)  

Barcha asboblar qatlamlar bilan ishilaydi lekin bu bilan qatlamning 

shaffofsizligiga kata tasir o’tkazadi shuning uchun qatlam 

shaffofsizligini dimo nazorat qilib turing.  

Qatlamni uchirish(Udalenie sloya iz nabora)  

Qatlamni uchirishdan oldin uni nomini aktivligini tekshiring, va uni 

belgilab o’chirib tishlang.  

Qatlamga effektlatqkullash(Primenenie effektov sloya)  

Qatlamga quydagi maxsus effektlarni qulash mumkin: Drop 

Shadow (Otbrosit ten), Inner Shadow (Vnutrennyaya ten), Outer 

Glow (Vneshnee svechenie), Inner Glow (Vnutrennee svechenie), 

Bevel and Emboss (Skos i relef), Satin (Atlas), Color Overlay 

(Nalojenie tsveta), Gradient Overlay (Nalojenie gradienta), Pattern 

Overlay (Nalojenie uzora) va Stroke (Кayma). Effektlarni istalgan 

paytda istalgancha istalgan qatlamga qo’lash mumkin lekin qatlamni 

shaffofsizligini tekshirib turing.  
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Eslatma  : Uslub(stili) va effektlarni bir biri bilan chalkashtirib 

yubormang. Uslub(Stil) – bu bir qancha qatlam effektlarini 

xamoxangligidir.  

Effektlar Layer Style (Stil sloya) muloqat oynasi orqali amalga 

oshiriladi.  

Effekt yonidagi galochka bu effektk shu qatlamga qo’lanilganini 

ko’rsatadi. qatlam effektlarini asosiy fon uchun qulash mumkun 

emas.   

Xama qatlamlarni birgalikda ishlatish(Zadeystvovanie vsex sloev)  

Agar optsiyalar panelida ko’ydagi asboblar ishlatilayotgan bo’lsa: 

Blur (Razmytie), Sharpen (Rezkost), Smudge (Palets), Paint 

Bucket (Vedro s kraskoy), Magic Eraser (Volshebnyy lastik) ili 

Magic Wand (Volshebnaya palochka) unda Use All Layers 

(Ispolzovat vse sloi) bo’limiga bayrokchani urnating shunda rang va 

boshqa o’lchamlar olinayotganda mavjud bo’lgan ranglarga yaqin 

bo’lgan tuslar birinchi navbatta ko’rinadi. Faqat aktiv bo’lgan 

qatlamda ranglar o’zgaradi 

Ikki qatlamni birlashtirish(Sliyanie dvux sloev)  

1. Birlashtirmokchi bo’lgan ikki qatlamdan qaysi birisi oldinro 

bklsa uni belgilang.  

2.  Layers (Sloi) menyusidan Merge Down (Slit s nijnim) 

komandasini belgilang yoki  Ctrl+E  tugmalarini birgalikda bosing . 

Aktiv qatlam o’zidan pastda turgan qatlam bilan birlashadi. Bir 

qancha belgilangan qatlamlarni birlashtirish uchun  Merge Layer Set 

(Slit nabor.sloev)komandasini tanlang.  

Qatlamlarni birlashtirish(Ob’edinenie sloev) 

Dikkat : Flatten Image (Ploskoe izobrajenie) komandasi 

qatlamlarni pastdan boshlab birlashtiradi va yashirilgan qatlamlarni 

avtomatik tarzda o’chiradi.  

Xama qatlamlar ko’rinib turganligiga amin bo’ling va qaysi qatlam 

aktiv bo’lishi muxim emas. Layers (Sloi) menyusidan Flatten 

Image (Ploskoe izobrajenie) komandasini tanlang. Agar 

programmada bekitilgan qatlamlar bo’lsa unda ogoxlantirish beriladi 

va OК tugmasini bosing va birlashtirishni davom etiring. Agarda 

pastki qatlamlarda ko’rinmaydigan nuqtalar bo’lsa ular oq ranga 

kiradi.   

QКatlamni uchirish(Udalenie sloya)  
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Layers (Sloi) menyusidan keraksiz qatlam nomini tanlang. Sungra 

Trash (Кorzina) tugmasini bosing va Yes (Da) tugmasini xam 

bosing.  

Qatlamni uchirishni Yana bir usuli keraksiz qatlam nomi ustiga 

olib borib sichkonsani o’ng tugmasini bosing va menyudan Delete 

Layer (Udalit sloy) bo’limini tanlang xamda  Yes tugmasini bosing.  

 

  Nazorat savollari: 

1. Qanday usulda qatlamlar xosil qilinadi? 

2. Qatlamlarga qanday effektlar qo’lash mumkin? 

3. Ajratilgan qisimda yangi qatlamni xosil qilishni ko’rsatib 

bering.       

 

 

5- amaliy mashg’ulot 

 

 

COREL DRAW   dasturi bilan tanishuv.  COREL DRAW  

dasturida  

xujjatlarni yaratish va ochish. 

 

Ishning maqsadi: COREL DRAW  dasturi imkoniyatlari 

bilan tanishish. 

 

Vazifa: 

 

1. Nazariy qism bilan tanishing. 

2. COREL DRAW   dasturi yordamida yangi xujjat ochishni 

o’rganing. 

3. COREL DRAW   tafsiyanomalari bilan tanishing. 

 

Nazariy qism. 

 

Yuqlangandan sung dastur ekranga «Xush kelibsiz SOREL 

DRAW»  mulokot oynasini chiqaradi va bir nechta variantlarni taqdim 

qiladi: yangi xujjat yaratish (GRAPHIC), oxirgi yaratilgan xujjatni 

ochish (Orep last edited), mavjud xujjatni ochish (Orep GRAPHIC), 

o’qitish tizimi (COREL TUROR). 
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Yangi xujjatni yaratish uchun fayl (FILE) menyusida Yangi 

(NEW) komandasini bajariladi. Mavjud xujjatni ochish uchun fayl 

menyusida ochish (Oren) komandasi bajariladi. 

COREL DRAW   dasturi bir necha xujjatlarni bir vaqtda 

ochish imkoniyatiga ega, u xolda shu paytda kerak bo’lmagan 

xujjatlarni yopish kuzda tutilgan. Menyu Fayl (FILE) bo’limida yoping 

(Zakryt, Close) komandasi bajarilganda aktiv xujjat yopiladi. Dastur 

yuqlangandlan so’ng ekranda paydo dastur oynasiga foydalanuvchining 

interfeysi deyiladi(User1Tzeg t1egtaze). Interfeys inson va kompyuter 

orasida bog’lovchi bo’lib ishlash uchun panel, asboblar, muloqot 

oynasi va x.k larni taklif etadi. Foydalanuvchi interfeysiga saxifa, 

bosh menyu, xujjatlarni aks ettiruvchi ishchi oynalari xamda tasvirlarni 

muxarrirligini amalgam oshiruvchi xar xil panellar tuplami. Oynaning 

markazidagi katta oq maydon ishchi ishchi xudud bo’lib xar bir xujjat 

aloxida - aloxida ochiladi. Ekranning tepa qismida bosh menyu 

bo’limlari quyidagicha nomlanadi: 

• Fayl (File) 

• Muxarrir (Redaktirovanie, Edit) 

• Кo’rinish (Prosmotr, View) 

• Кampanovka (Layout) 

• Boshqaruv (Upravleniya,    Arrange) 

• Effektlar(Effects) 

• Nuqtaviy tasvir  (Toch.izob, Vitmaps) 

• Matn (Text) 

• Servis (Tools) 

• Oyna (Okno,Windows) 

• Yordam (Pomoщ, Ne1r) 

 

 

Bu komandalarning xar biri funktsional jixatdan yakinbulgan 

amallarni bajaradi, masalan: matn menyusi matn bilan ishlaydigan 

komandalardan iborat, effekt menyusi nuktaviy va vektorli grafikani 

yaratadigan komandalar tuplamidan iborat. 

Xossalar asboblar qatori ( Rgoreggu Var) 

Xossalar asboblar qatoridagi ( Rgoreggu Var) maydonlar va 

tugmalar to’plami ,ishlatilayotgan asbob yoki belgilangan ob’ekt turiga 

bog’liq xolda 
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Ko’rinishga ega bo’ladi, masalan, matn blokka olinganda xossalar 

katorida matn parametrlari aks etadi. COREL DRAW  Ob’ektlar 

belgilanmagan xolatda xossalar qatorida (Rgoreggu Var) xujjatning 

umumiy parametrlari beriladi, masalan: varakning formati, joylashuvi va 

boshqalar. 

Xolat qatori   (Status  Var) 

Ishchi ekranning pastki qismida xolat qatori (Status  Var) 

joylashgan bo’lib turli xil  

 
xizmat ma’lumotlarini aks ettiradi: parametrlar, obvodka va ranglar, xarf 

parametrlari ajratilgan ob’ektlar xaqida ma’lumot va aktiv asboblar 

xaqida ma’lumot. Bu qatorning, kurinishi xolati va tarkibini o’zgartirish 

mumkin. 

 

Asboblar paneli(Toolbox) 

Ishchi oynaning chap tarafida asboblar paneli joylashadi. Bu 

panelda barcha instrumentlar joylashgan bo’lib, ular yordamida turli 

grafik ob’ektlarni yaratish ajratish, taxrirlash mumkin. 

Asboblar bilan ishlayotgan paytda belgilangan ob’ektga bog’lik 

xolda kursorning ko’rinishi uzgaradi. Bundan tashkari asboblar 

panelida ba’zi asboblarni ajratib olish mumkin, bunda bu gruppalar 

«suzuvchi» panellar yoki Fluoyut kurinishdagi panellar shaklida bo’uladi. 

Docker tipidagi panellar muloqot oynalarining bir ko’rinishidir. Bu 

panellar ekranda doimiy joylashgan bulishi mumkin bulib, xujjatlarning 

ishchi oynalari bilan muloqotda bo’lishi mumkin. Oyna (Window) 

menyusida Docker tipidagi komanda bajariladi va ochilgan ruyxatdan 

keraklisi tanlanadi. 

• Panel Object Manageg (Dispetcher ob’ektov) - ob’ekt va 

qatlamlarning parametrlarini aks ettiradi. 

• Panel Virw Manageg (Dispetcher vidov) - akslarining 

ko’rinishlarini yaratish va boshqarish uchun. 

• Panel Graphic and Text Styles (Stili teksta i grafiki) - grafik 

va matnli obektlarni yaratish va nomlanishi uchun. 
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• Panel Co1or Styles (Цvetovye stili) - ranglar 

to’plamidan foydalanish uchun. 

 

• Panel Symbols and Special Characters 

(Simvoly i spetsialnye znaki) - dekorativ simvollar sinfi 

tanlash uchun. 

• Panel Internet Bookmark Manageg 

(Dispetcher zakladok Internet) - matnli gipermurojatlarni 

yaratish va boshqarish uchun. 

• Panel NTML Object Conflict 

(Analizator konfliktov ob’ektov NTML) - xujjatlarni 

korrektsiyalash va tekshirish, Internet tarmog’i orqali 

taqdim etish uchun. 

• Panel Script and Preset Manageg 

(Dispetcher makrosov i gotovyx obraztsov) - 

makroprgrammalarni yozish va sozlash uchun uchun. 

• Panel Object  Data (Baza dannyx) - 

xujjatdagi jadvalni xar bir ob’ektlarini ma’lumotini 

o’zlashtirish, masalan: o’lchami, narxi va boshqalar. 

• Panel Object Rrorerties (Svoystva 

ob’ektov) - xujjatdagi ob’ektlarni parametrlarini 

o’zgartirish va aks ettirish uchun. 

• Panel Link Manageg (Dispetcher 

svyazannyx izobrajeniya) - xujjatda bo’lmagan ammo u 

bilan aloqada bulgan tasvirlarni boshqarish. 

• Panel Vitmap So1og Mask (Цvetovaya 

maska tochechnogo izorajeniya) - nuktaviy tasvirlarni 

rangli nikoblarni yaratish uchun. 

• Panel Lens (Linza) - Linza turlarini 

tanlash va parametrlarini aniqlash uchun. 

• Panel Artistic Media (Imitatsiya) - 

murakkab ko’rinishdagi vektor muyqalami bilan ishlash 

uchun. 
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•Tgapsformation(Transformirovanie)paneli xar xil ko’rinishdagi 

transformatsiyani boshqarish uchun 

• Panel Shaping(Izmenenie formy) - bir nechta 

ob’ektlarning uchta ko’rinishini bittaga kombinatsiya kilish. 

• Panel So1og (Цvet)  i So1og Ra1ette  Vgowser (Цvetovye 

palitry) - rang bilan ishlash uchun 

• Panel Vgowse (Obzor) - dastur xujjatlarini kurish va 

boshqarish uchun 

 

 

•   Panellar Cliparts (Vektornye izobrajeniya), Rhotos (Fotografii), 

ZD models (Tryoxmernye modeli) - prouramma Bilan beriladigan SD-

ROM kompakt disklarini kurish uchun 

• Panel FTR Sites (Sayty FTR) - FTR saytlarga murojatlarni 

saqlash uchun va katta massivdagi axborotlar bilan ishlash uchun. 

 

Nazorat savollari: 

 

 

1.    COREL DRAW   dasturida qanday ishlar bajariladi. 

2.   Fayl bulimiga nimalar kiradi. 

3.    Dastur asboblar paneli xaqida ma’lumot bering. 
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                       6- amaliy mashg’ulot 

 

Dasturning ob’ektlari va ularning shakllari bilan ishlash. 

 

Ishning maqsadi: COREL DRAW ob’ektlari bilan 

ishlashni va tugri turtburchak, ellips,spiral chizishni urganish  

 

Vazifa: 
1. Nazariy qism bilan tanishing. 

2. Dastur yordamida tugri turtburchak chizishni urganing. 

3. COREL DRAW  dasturida geometrik figuralarni yaratishni 

urganing 

4.Ellips,spiral asboblarida ishlashni urganing. 

 

Nazariy qism 

 

COREL DRAW dasturi vektorli tasvirlarni yaratishda turli 

vositalarni qo’llaydi- ingichka chiziqlar,patsimon shtrixlar.Sho’nga 

karamay vektorli grafikaning ish usuli,"ko’lda" chizishdan ancha 

farq qiladi.Shuning uchun vektorli konturni yaratishni va taxrirlashni 

tasavvur qila olish kerak. 

Shu maqsadda COREL DRAW   dasturi geometrik figuralarni 

yaratish (tugri turtburchak, kupburchak, ellips, spiral) uchun muljalgan 

asboblarga ega,bundan tashqari "erkin chizish" asboblari (pero, 

kalligrafik, pero). Gradientli setka (Mesh Fill),  vektorli grafikaning 

asosiy instrumenta bo’lgan Bez’e — egri chiziqlari, Bez’e asbobi (Vezier). 

Vektorli konturlarni tuliq taxrirlash qanday asboblar orqali 

yaratilganligadan qattiy nazar bir xil usulda bajariladi: Forma (Share) 

asbobi yordamida, redaktor maxsus paneli (Node Edit) tarmog’i 

orqali yoki uni almashtiruvchi xossalar asboblar qatori (Rgoregtu Var). 

Кonturlar va tayanch nuqtalar 
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    Кontur (rath) bu chiziq bo’lib dasturning chizuvchi  

asboblar orqali yaratiladi va ob’ektning simli strukturasini  

tashkil qiladi.Кeyinchalik kontur obvodka parametrlarini (outine)  

va ranglarini (fill) taqdim qilishi mumkin va buning natijasida 

 u ko’rinishga ega bo’lib chop etilishi mumkin. Agar konturda  

qaysidir parametrlar etishmayotgan bo’lsa u oddiy rejimda  

ko’rinishga ega bo’lmaydi, to’liq ob’ekt shaklida xujjatda  

saqlansada, pechatga chiqarilmaydi. Forma (Shape) asbobi 

yordamida  

ajratish mumkin bo’lgan - kontur (tashkil qiluvchi kontur – 

 kombinatsiyalanuvchi konturlar yigindisidir), aloxida ob’ekt 

 xisoblanadi (oЬject). 

Odatda kontur ko’p segmentlardan tashkil topadi, bu konturlar  

tayanch nuqtalarida ulangan Bez’e egri chiziqlaridan tashkil 

topgan. Segmentning bir tayanch nuqtasi joyini o’zgartirishi 

 shaklni o’zgartiradi. Segment shaklini boshqaruvchi nuqtalar 

orqali xam o’zgartirish mumkin. 

     Standart geometrik figuralarni (tugriturtburchak, elips, yoy, 

aylana) yaratish uchun muljallangan asboblar sichqonchaning bir 

xaraqati orqali geometrik figurani chiza oladi. 

 

Tug’ri turtburchak (Rectangle) 

 

Tugriturtburchak asbobi istalgan tugriturtburchak yoki 

kvadratlarni chiza oladi. Tugriturtburchak chizish uchun asbob ustida 

sichqoncha tugmasini bosib quyib yubormagan xolda kerakli o’lcham 

olinadi. Agar tugriturtburchakni markaziy nuqtadan chizish lozim 

bo’lsa,<Shift> tugmasini bosib turish kerak, kvadrat chizish uchun <Stgl> 

tugmasi ishlatiladi. 

 

 

Ajratilgan ob’ektda ung tugma orqali kontekst menyusini chaqirish 

mumkin, bunda ekranga ob’ekt xossalari paneli chiqadi. Bu 

panelda tug’rito’rtburchak asbobi va chetlari silliqlangan burchaklar 

maydoni bo’lib bunda xar bir burchakni silliklanishi foyizlarda 

ifodalanadi Silliqlangan burchaklarni  Forma yoki Strelka asboblari 

orkali yaratish mumkin.Buning uchun sichqoncha ko’rsatkichini 

to’rtburchak burchagiga olib kelib bosib turgan xolda chetga 
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tortiladi. 

 

 

Ellips asbobi (Ellipse) 

 

Ellips asbobi ellipslar va aylanalar chizish uchun muljallangan.  

Ellips o’ziga tashki chizilgan to’rtburchak burchaklaridan 

boshlab chiziladi.Ellipsni chizish uchun markazda <Shift> tugmasi, 

aylana uchun <Stg1> bosilishi lozim.Ob’ekt xossalari paneli erdamida 

ellips parametrlarini o’zgartirish mumkin. Ellips tugmachasining 

yukori qismidagi vkladka orqali ellipsning tipini tanlash 

mumkin.Ellips, Sektor, Yoy.Bu tugmalar xosalar asboblar qatorida 

qaytariladi. 

Uchta asbob, ko’pburchak (Ro1ugon), Spiral (Spiral), 

Кordinata varaq i (Graph Paper), ob’ekt guruxiga yig’ilgan bo’lib 

asboblar panelidan aloxida panel ko’urinishida ajratish mumkin. 

 

Spiral asbobi (Spiral) 

 

 Spirallar yaratish uchun muljallangan yoki uzluksiz egri 

chiziqlar shaklidagi geometrik shakillarini yaratish mumkin. Spiral chizish 

jarayoni turtburchak chizish jarayoni bilan bir xil. Spiral asboblari 

bo’limidan semetrik va logorifmik tugmalar orqali spiral turini tanlash 

mumkin. Muntazam spiral yaratish uchun <Stg1> tugmasini bosib turish 

kerak. Spiral parametrlarini xossalar asboblar qatoridan o’zgartirish 

mumkin. 

 

 

. 

 

Nazorat savollari: 

 

1.Dasturda kvadrat chizish uchun qaysi standart tugma 

bosiladi. 

2. Tugri to’rtburchak asbobi erdamida nimalar chizish 

mumkin. 
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3. Dasturda geometrik figuralar qanday yaratiladi. 

4.Кontur va tayanch nuqtalar xaqida ma’lumot bering. 

5.Dasturda ellips figurasi qanday yaratiladi. 

6.Dasturda spiral figurasi qanday yaratiladi.

 

7-amaliy mashg’ulot 

 

SOREL DRAW  dasturida murakkab chiziqlar va 

shakllar xosil kilish  
 

 

   Ishning  maqsadi: Кordinata kog’ozli asbobi bilan 

parametrli reshyotka yaratish. Кupburchak asbobi (Ro1ugon) 

bilan ishlashni urganish. Bez’e asbobi imkoniyatlari bilan 

tanishish. 
 

Vazifa: 

 

1.Dasturda kordinata qog’ozli asbobi (Graph Paper), Chizish 

asboblari (Freehand) bilan ishlang. 

2. Dastur erdamida ko’burchak chizishni o’rganing. 

3. Dasturda to’g’ri chizikni yaratishni o’rganing. 

4. Bez’e asbobi bilan ishlashni o’rganish. 

 

Nazariy qicm 

 

Egri chiziqlar guruxi asboblari (Surve) 

 

Egri chiziqlar guruxi asboblari panelida quyidagi 

uskunalar bor: Chizish (Freehand), Bez’e (Vezier), Pero (Natural 

Pen), Chizik ulchami (Dimension), Boglovchi chizik (Sonnector 

Line) va Boglovchi (Sonnector).  

 

 

 

Кo’pburchak asbobi (Ro1ugon). 
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Кo’pburchakni, kerakli tomonlarga ega bo’lgan 

geometrik ob’ekt sifatida tushunish mumkin. Кo’pburchakning 

bir varianti sifatida yulduzchani olish mumkin, bunda ichki 

chizilgan ko’pburchakni maydonini kesib utadi. Кo’pburchakni 

yoki yulduzchani chizish to’rtburchak chizishdan farqi yo’k. 

S1g1 tugmasini bosib turgan xolda muntazam ko’pburchak 

chiziladi. Кupburchak parametrlarini ob’ekt xossalari paneli orqali 

o’zgartirish mumkin. 

Кo’pburchak vkladkasini tanlab ushbu panelda tomon 

qirra maydonida ko’pburchakning qirralar sonini kiritish 

mumkin. Qirralar o’tkirligi maydonida shartli birliklarda 

qirraning o’tkirlik darajasini kiritish mumkin. Кo’pburchak va 

yulduzcha tugmachalari ko’pburchaklarni tanlash imkonini 

beradi. Barcha ushbu maydon va tugmachalar xossalar asboblari 

qatorida qaytariladi 

 

 

Shuni aytib utish kerakki dasturda ba’zi kelishmovchiliklar 

xam bor. Masalan, parametrlar muloqot oynasida ko’pburchakning 

yulduzcha shaqlidagi yana bir turi mavjud. (Ro1ugon as Star) 

 
 

Кoordinata  qog’ozli asbobi (Graph Paper) 
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Кordinata 

qog’ozli asbob berilgan 

parametrli reshyotka 

yaratish imkonini 

beradi.Bunday 

reshyotkani grafiklar 

yoki diagrammalar 

uchun koordinatali asos 

qilib olish mumkin.Bu 

instrument 

parametrlarini, 

parametrlar muloqot 

oynasida koordinatali 

qog’oz bo’limida 

o’zgartirish mumkin. 

Yacheykalar soni 

maydonida eniga 

(Number of cells wide) 

buyiga (Number of cells 

high) ko’ra yacheykalar 

miqdorini o’zgartirish 

mumkin.Кvadrat 

yacheykali reshyotkalarni 

tayyorlash uchun <Stg1> 

tugmasini bosib turish 

kerak.  

 

 

 

Chizish asboblari (Freehand). 
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Chizish asboblari 

istalgan chiziklrni chizish 

uchun mo’ljallangan. Bu 

asbob ishi natijasida 

vektorli kontur xosil bo’lib 

bu kontur tayanch nuqtalari 

dastur yordamida avtomatik 

qo’yiladi. Bu konturlar 

ustida erkin taxrirlash 

imkoni mavjud. 

 
 

 

 

Bu asboblarda chizayotgan paytda liniyalar kalinligi va 

obvodkalar rangini uzgartirish mumkin. Chizib bulingan chizikni 

istalgan paytda davom ettirish mumkin. Buning uchun kursorni 

uning oxirgi nuktasiga olib kelib (kursorning egri chiziklari 

kursatkichga aylanadi), sichkoncha tugmasini bosgan xolda 

chizikni davom ettirish xamda chizish asboblari yordamida tugri 

chizik chizish mumkin. 

Bez’e asbobi erdamida maksimal aniklik va maksimal 

ratsionallik bilan ixtieriy konturni yaratish mumkin. Bu asbob 

foydalanuvchini grafik dizaynda barcha narsani xal kiluvchi Forma 

yaratuvchisiga aylanishiga imkon beradi. 

Tugri chizikli sigmentlar tuzish. 

Tugri chizik yaratish uchun Bez’e asbobi kulay keladi. 

Buning uchun Bez’e asbobini tanlash kerak. Кursorni boshdangich 

nuktaga olib kelish va sichkonchaning chap tugmasini bosish 

kerak. Tugma bosilgan joyda segmentning boshlangich tayanch 

nuqtasini ifodalovchi ko’ra nuqta paydo bo’lad. U keyingi nuqta 

yaratilgunga kadar aktv bo’lib turadi . So’ng kursirni keyingi 

nuqta joylashadigan yangi joyga olib o’tish kerak . Ikki nuqta 

Tug’ri chiziq bilan tutashadi. 

Tayanch nuqtalarning turlari. 

Bir necha segmentlarning tutashishida tayanch nuqtalari 

Corel Draw dasturida uch tipli bulishi mumkin : 
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1. Ikki egri chiziqni "bukilishda" tutashtiruvchi tayanch 

nuqtasi - burchak tayanch nuqtasi deyiladi . (cups node) BundaY 

tayanch nuqtasida boshkaruvchi chiziqlar xam yunalishi ,xam o’zinligi 

buicha mustaqildir. 

2. Ikki egri chiziqni sinishsiz tutashtiruvchi tayanch nuqtasi -

silik tayanch nuqtasi deiladi (smooth node) Bunday tayanch 

nuqtalarda boshqaruvchi chiziqlar bir-biridan faqat o’lchami bilan 

gina mustaqil, yonalishi bo’icha esa umumiy tutashuvchi tug’ri 

chiziqni tashkil qiladi .Boshqaruvchi chiziqlarni birining o’rin 

almashishi ikkichi xam o’rin almashishiga olib keladi. 

3. Sinishsiz va bir xil qiyalik bilan tutashgan tayanch nuqtasi 

simetrik tayanch nuqtasi deiladi (symmetrcal node). Bunday tayanch 

nuqtalarda boshkaruvchi chiziqlar bir-biriga xam yonalishi, xam 

kalinligi bilan bog’lik 

 

                                                         

 

Nazorat savollari: 

 

1. Egri chiziqlar guruxi asboblari panelida qanday uskunalar bor. 

2. Dasturda ko’pburchaklar qanday yaratiladi. 

3. Кordinata qog’ozli asbobi (Graph Paper)ning imkoniyatlari. 

4. Chizish asboblari qanday chiziqlar chizish uchun 

mo’ljallangan. 

5. Tayanch nuqtalari Corel Draw dasturida necha tipli bo’lishi 

mumkin. 

6. Tug’ri chiziq yaratish uchun qanday asbob qulay keladi. 
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8- amaliy mashg’ulot 

 

COREL DRAW  dasturida ob’ektlarni purkash, rang 

bilan ishlash. 

 

Ishning maqsadi: Dasturda ob’ektlarni purkashni 

o’rganish. 

Imitatsiya asbobi yordamida murakkab tuzilishga ega 

bo’lgan bezakli shakllarni yaratish. 

 

Vazifa: 

 

1 .Nazariy qism bilan tanishing. 

2. Ob’ektlarni purkash ishi qanday amalga oshirilishini 

o’rganing 

3. Dastur erdamida murakkab tuzilishga ega bo’lgan bezakli 

shakllarni yaratish. 

 

Nazariy qicm 
Imitatsiya asbobi (Artistic Media). 
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Imitatsiya 

asbobi nuqtali 

grafika dasturlarida 

ko’prok ishlatiladi. 

Shunga qaramay 

vektorli dastur xam 

bu asbobni taqdim 

etadi.Bu asbob 

orqali Peroda 

chizish o’pnini bosa 

oladi, shu bilan 

birga bezakli 

shtamp o’rnini 

xam bosadi. Bu 

asbobning  

joyibligi shundaki u 

asosiy konturni 

chizib, bu kontur 

bo’ylab turli 

obe’ktlar joylashib 

manzarali va 

grafik effektlarni 

beradi. 

Na’muna 

rejimi (Rgeset) bu 

rejimda shunday 

obe’ktlarni yaratish 

mumkinki, bunda 

bu obe’ktlar tayyor 

na’munalarga 

qarab o’z shaklini 

o’zgartiradi. Bu 

rejimda shakilli 

chiziqlarni ishlatish 

mumkin. 
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Muyqalam rejimi (Vrush) bu rejimda murakkab tuzilishga ega 

bo’lgan bezakli shakillarni yaratish mumkin. 

Purkagich rejimi (Object Sprayer) kontur trektoriyalari bo’ylab 

turli grafik obe’ktlarni joylashtiradi. Bu rejim murakkab ramqalar, 

bezakli qatorlarni yaratish uchun muljallangan. 

Кalligrafiya rejimi (Sallligraphis) bu rejimda kalin pero yoki enli 

muy qalam egri chiziqlarini chizish mumkin. 

Bosim rejimi (Rgessure) bu rejimda shunday chiziqlarni chizish 

mumkinki bu chiziqlarni klaviatura orqali boshkarish mumkin. 
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Na’muna rejimi (Rgeset). 

Xossalar asboblar qatorida bu rejim tanlansa quyidagi 

parametrlarga ega bo’lamiz: tekislash maydoni (Freehand Smoothing) 

asosiy chiziqni 0 dan 100 diapazonigacha tekislash imkoniyati.(rasmda 1 

raqami bilan ko’rsatidgan) 

O’lcham maydoni (Size)(2 rakam)bezakli shtrixlarning 

o’lchamini foizlar xisobida o’zgartish imkonini beradi . 1 dan 999% gacha. 

Ob’ektlar ro’yxati maydoni (3 raqam) bu ro’yxatda turli 

formadagi purkaladigan ob’ektlarning namunalari keltirilgan. 

Save tugmachasi (4 raqam) muyqalam rejimida ish yuritish 

bilan bir xil. 

Uchirish tugmachasi (Delete) ro’yxatdagi xoxlagan variantlardan 

birini uchiradi. 

Purkash tartibi (Sgau Ogdeg) (6 raqam) ob’ktning kontur 

bo’ylab joylashish ro’yxatini taqdim etadi - Tasodafan (Ramdom1u), 

Кetma-ketli (Sequendally), Yunalish buylab (Vu Digektion). 

Ob’ektlar ro’yxatiga ko’shish tugmasi (Add to SprayList) (7 

rakam ) ob’ektlar ro’yxatiga ya ngi elementlarni qo’shish imkoniyatini 

beradi. Ulardan keyinchalik "Uynovchi" qatorini (play list) tashkil qilish 

mumkin. 

Ob’ektlarni purkash (Object Sprayer) ni tanlanganda xosalar 

asboblar qatorida ko’ydagi parametlarga ega bo’lamiz: 

(Sglajivanie) maydoni (Freehand Smoothing) (rasmda 1 rakami 

bilan ) - 0 dan 100 gacha diapazonda bolgan asosiy shtrixni tug’irlash 

darajasini aniqlash uchun mo’ljallangan. 

O’lchamlar maydoni (Size) (2 rakam) 1dan 999% gacha 

diapazondagi 

Boshlang’ich min. va mak. O’lchamlarni foizlarda aniqlashga 

imkon beradi. Ob’ektlar ro’yxattida (Spraylist:) (3 raqam) turli xildagi 

purkaklaninuvchi ob’ektlarning keng tanlash (dakarativnyx) 

namunasi berilgan.Save tugmasi (4) ming ishlash jarayoni moy- 

qalam (Vrush) rejimida ishlash jaroyonidan farq qilmaydi. Uni SD- R 

formatida saqlash imkonini beradi. 

O’chirish tugmasi (Delete) (5) ruyxatdagi ixtiyoriy variantni 

ochirish imkoniyatlarni beradi. 

 



 45 

Purkash tartibi ro’yxati (Srgau Order) (6) kontur bo’ylab 

ob’ektlarni taksimlash usullarining ruixatini - Tasodifiy (Ramdomly), 

ketma ket (sequentially), Yunalish boicha (Vu Direktion) Ob’ektlar 

ro’yxatiga ko’shish tugmasi (Add to Spraylist) (7) ob’ektlar ro’yxatiga 

yangi elemertlar qo’shish imkoni beradi. Ulardan keinchalik 

«uynnovchi» sostav tashkil kilinishi mumkun. 

Ob’ektlar ruixatini aktivlash tumasi (Spraylist Dialog) (8) 

aktiv elentlar ruixatini yaratish muloqat oinasini ekranga chiqaradi 

unda 2 ta oyna ko’rsatilgan: barcha ob’ektlar ro’yxati oynasi (Spraylist) 

va aktiv ob’ektlar oynasi (R1aulist). 

Ob’ektlar maydoni / intervalar (Dabs/Spasing) (9) ob’ektlar 

va intervallar sonining o’zaro aloqasini o’zgartirish imkoni beradi. 

intervalar (Spacing) quyi maydonda ob’ektlar moxiyati orasidagi 

intervallarni aniqlaydi, yuqori ob’ektlar (Dabs) maydonida esa - xar-

bir interval nuqtasidagi shu ob’ektlar sonini. 

Aylanish tugmasi (Rotation) (10) ekranga barcha ob’ektlar 

aylanishining parametrini o’zgartirishi mumkin bo’lgan qo’shimcha 

oynani chiqaradi. 

Joy o’zgartirish tugmasi (Offset) (11) ekranga ob’ektlarning 

konturga nisbatan ko’chish yunalishi va qiymatini o’zgartirish 

mumkin bo’lgan qo’shimcha oynani chiqaradi. Qiymatni tiklash 

tugmasi (Reset Value)(12) moe faylda saqlangan boshlang’ich qiymatni 

qaytarishi mumkin. 

Кalligrfiya rejimini tanlashimiz bilan Svoystva (Rgoregtu Var) 

asboblar panelida quyidagi parametrlarga yo’l ochiladi : 

Tekislash maydoni (Freehand Smoothing) (1-raqam bilan 

belgilngan) va kenglik (Width) (2)lar Muyqalm kabi funktsiyalanadi 

Burchak (Angle) (3) maydoni muykalamning ogish burchagini aniqlash 

uchun xizmat qiladi. Svoystva asboblar chizig’ida Najim rijimi 

tanlanganda quyidagi parametrlarga yo’l ochiladi: 

Tekkislash maydoni va kenglik muyqalam shtrixi qalinligini 

boshqarish tugmalar erdamida ta’minlanadi. 
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Nazorat savollari: 

 

1. Imitatsiya asbobi (Artistic Media)-deganda nimani tushunasiz. 

2. Кalligrafiya rejimi (Sallligraphis)da qanday chiziqlarni chizish mumkin. 

3. (Vgush) rejiming vazifasini tushuntiring. 

4. Ob’ektlarni purkash nima ? 

5. Spraylist Dialog-tugmachasining vazifasi. 

6. Aylanish tugmasi (Rotation) ning vazifasi. 

 



 47 

Mundarija 

 

1. Adobe Photoshop 7.0 Programmasi bilan tanishuv ........................... 3. 

2. Adobe Photoshop dasturida tasvir va rasm bilan shlash .................... 9 

3. Matnlar bilan ishlash .......................................................................... 16 

4. Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar 

(sloy) bilan ishlash ................................................................................. 23. 

5. COREL DRAW dasturi bilan tanishuv. COREL DRAW 

dasturida .......................................................................................................... 28 

6. Dasturning ob’ektlari va ularning shakllari bilan ishlash ......................... 33 

7. COREL DRAW  dasturida murakkab chiziqlar va shakllar xosil 

qilish ...................................................................................................................... 36 

8. COREL DRAW  dasturida ob’ektlarni purkash, rang bilan ishlash ............ 41 

 


